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1. Features

® [nstallation Wizard & PC Wizard, help non-experienced users to set-up servers &
applications easily

WiFi 802.11g AP router platform

Support various Internet connections

Dynamic DNS, allowing dynamic or private IP assigned to your servers
NAT-Firewall engine

Surfing-Net Control by user name, MAC id, time budget, and weekly schedule
Printer server supports printer sharing over Intranet and Internet

E-mail server allows users to send/receive mails with web or Outlook

Instant Message

Guest accounts are allowed to share & access personal files & messages
Web server & Web page DIY, allows users to create & post his web pages easily
Personal web pages & Portal pages

Network Access Storage (NAS) supporting web & network neighbor access
Streaming NAS to serve WS-30X Media Adapters

Personal Photo Album with network access & sharing capability

Personal Video/Music Library with network access & sharing capability

SIP VoIP server allows users to make free long-distant phone calls, no matter
where they are.

Web-based address book, with import export capability, compatible with PCs
Easy system maintenance & trouble-shooting

2. Start-up
2.1 Product Package Content
The package should contain the following items:
(1) One SC-203 unit
(2) One 12VDC Power adapter
(3) Two dipole antennas
(4) One Quick Guide, such as this one
(5) One CD including PC Wizard and User Guide

2.2 Device Installation
1. Screw-in the two antennas onto the SC-203. Place the device in the center of
serving area, keep from metal obstacle as possible.
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2. Follow Step 1, 2, 3 shown on labels: (1) insert the +12VDC power adapter, (2)
insert WAN cable, (3) finally turn on the Power switch. Don’t plug-in wrong
power adapter.

DDNS Server
dyndns.org
D 1. Wiring step 12 3 :
1 1. Wiring step 123 | 2. Device boot-up in 90 sec !
i 2.Device boot-up in35 sec ;  T/———  Totoooooooomooootoooooooooooos
Printer SC-203 J  ADSLjodem
o= [n gmp] [dog]
—
AN AN Line N
3-in-1 bu'xess machine
! 3. Windows/ IE set LAN i #
! 4. http://192.168.5.1 L ]
| 5. Auto-run Install Wizard to set: | ! 6. Install WiFi card or built-in WiFi :
-ADSL user account, password i 7. Windows/XP wireless network : set “sc203"
-System time ! on top of Preferred Network list
-DDNS i 8. AWiFi icon on the bottom-right corner, indicate

SC203 you are connecting to.
i 9. Do Internet web surf or ping an Internet host

Basic Settings

3. After you push the Power button, system starts to boot, the Power LED is
blinking before Internet connection is setup successfully.

4. The gateway is ready to use when the LEDs are in the following status:
Power: steadily on
WAN: on or blinking (if WAN cable plug-in)
LAN: on or blinking (if LAN cable plug-in)
HDD: on
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5. The default settings of the SC-203 can be found at the bottom of the unit, such
as:
IP address: 192.168.5.1
MAC id: 00-0A-C7-XX-XX-XX
SSID: sc203

6. SC-203 supports Web Ul. Have one PC connected to the LAN port of the
SC-203 to do configuration. Open the PC browser, type in http://192.168.5.1,
and enter to “Install Wizard” (See Section 1.3)

7. For further applications, refer to Chapter 2 of this guide. An update and
complete User’s Manual are available on the web-site
http://www.uni-wlan.com).

8. If you cannot access Internet via SC-203 or find something wrong, please
check Power LED for instant diagnostic
Power LED status

Status Period (blink-stop-blink) Description
1 Blink 2 sec, on 3 sec, blink 2 sec, System is doing disk check
repeat until disk check complete
2 System will scan and detect network WAN port NOT connected to Internet

status every 30 minutes and will
Blink 4 sec, on 3 sec, blink 4 sec

3 System will scan and detect network Poor performance in WAN connection
status every 30 minutes and will
Blink 6 sec, on 3 sec, blink 6 sec

4 Blink 8 sec, on 3 sec, blink 8 sec Run WAN port Power-on-self-test fails

5 Blink 10 sec, on 3 sec, blink 10 sec Run LAN port Power-on-self-test fails

6 Blink 12 sec, on 3 sec, blink 12 sec Run WLAN (WiFi) port Power-on-self-test fails
7 Blink 14 sec, on 3 sec, blink 14 sec Run USB port Power-on-self-test fails

2.3 Device Shut-down
To shut-down (turn the power off) or reset the unit, please follow these steps:

B Press and hold the Power button for 2 seconds, then release

B Wait for the system to shut-down. It takes about 10 seconds for all LEDs to
turn off

B Then press the power button to restart the system

B Warning: Always use the Power button on the front panel to turn the system
off. It is abnormal to un-plug the DC power directly and it will take more than
10 minutes for system to do disk check when next time you turn-on the
device.
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2.4 Device Configuration with “Install Wizard”

1.

Open Internet Explorer on your PC and enter http://192.168.5.1. If the device is
in “factory default” configuration, the Installation Wizard would auto-run. It will
auto detect the network connection methods. Click “Auto Configure” to
continue.

SC-203 Install wizard

Thanks for choosing SC-203 as your gateway to the home entertainment and world
of infotainment. It's recommend to use Auto Configure to setup your gateway
automatically or you may wish to configure the gateway manually

| Configure Manually | Auto Cenfigure == ‘

Please wait a bout 1 minute for Install Wizard to run. It can detect what
connection (DHCP, PPPoE, or Fixed IP) the WAN port is fit to. Then follow the
instruction to complete the Install Wizard settings. If you have difficulty, refer to
on-line Help

When you finish above settings, the services status table will appears. It tells
you which servers are available to work. Please click on “Save this set” button
to the next step. A similar status table can be seen in Admin page. Further
settings (e.g. DDNS) in Admin page will make disabled servers activate
automatically
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- Warning! -
Internet UnReachable

e

[ oti i
ubsmestion o | St el services

Ernail server

Access Control

WiF v
MALC Changa«l
DHCP server 4’
Ut se“i"v] SIP server 4’
Setting List | Strearn server Y 4
Print
. rinter server @

4. Now the SC-203 setup is successful, click on “Configure Complete!!” button to
save and activate it.

5. Then you will see the SC-203 user interface, and you can access the Internet
instantly.

« Help Message :

_.——\_
s

Unication

{ . SC-203
Server Center/SC-203
IP Address:192.168.5.1
Domain Mame: http://.
Access Contro Statusl: Turn Off b ‘ - )
[ (Start access control will control all users to surf internet.) |

| 4

Welcome to My Web Site

Select User Identity /

Hella! My name is Harry Huang. | am 4
years old now. It's nice to meet you. This is
our family weh site. Thanks for visiting us

6. Open your browser and type in the address bar like http://www.yahoo.com to
test if you can go to Internet.
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3 Basic Settings

Basic Settings include:
(1) WAN settings (You have done in Install Wizard) modification,
(2) Time settings (You have done in Install Wizard) modification,
(3) DDNS settings,
(4) member account setting,
(5) WiFi settings on PC.

‘ ( « Help Message : ‘

Unication T

Server Center/SC-203

st

[ Tirne 199771201 02:38:09

|IP Address (19216851 / Eﬂ@ J}n}rgge ><Deaeee Sea% Enter keyword (€3

|Change My Password M web Portal Edit - Public Message Board

—

Aiccount Control i
ook to Uieh Portal Edit

3.1 WAN & Time Modification

(1) Administrator logins—>System Maintenance—>Time setting, run network time
again if Install Wizard did not get network time.

(2) Administrator logins>WAN settings—> select connection method, do some
modification if necessary.

(3) Click on “Save this Set” to do IP address Release/Renew. It is necessary
when you did not get or lose WAN IP address.

3.2 WiFi Settings on PC

® Windows XP has a built-in WiFi Utility. If your PC has WiFi built-in, use it and
enable Windows XP WiFi Utility.
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® |[f your PC is not WiFi ready, install a WiFi (or called WLAN) card and the vendor
provided Utility in your PC.

® You can use either (1) the Windows Utility or (2) card vendor provided Utility, but
never both. If the vendor’s Utility is installed, then Windows Utility has to be
disabled by means of un-checking the “Windows Connection”.

® Run Vendor Utility in PC, set SSID= “sc203” (default), then the WLAN LED
should be lit.

® Enter PC/Windows/Network to set the WLAN card IP address as dynamically -
assigned.

(1) From the Desktop, double-click on My Computer.

(2) Double-click on Control Panel.

(3) Double-click on Network, then select WLAN and click Properties.
(4)Select TCP/IP under the Configuration tab, and then click Properties.
(5)Set the IP address to obtain an IP address automatically and DNS

configurations to obtain DNS automatically.

® With Windows XP Utility, click on the wireless LAN icon on the bottom-right
corner of PC screen. If you don’t see the icon, click Start-> Setting—>Network
Connection. Enable the wireless connection.

® |n Windows XP Utility, enter SC-203 network name (ssid, default sc203) on the
top of Preferred network list. Therefore, your PC will always connects to SC-203
no matter the signal is weaker than other Access Points.

® To address SC-203, we recommend you to use domain name instead of IP
address, e.g. domain name for network printer, VolP server, Email box,
Web-server, NAS address. Thus your PC, no matter where it is, will be always
connected to SC-203 servers

3.3 DDNS Settings

DDNS (Dynamic Domain Name Service) is necessary for home servers with dynamic
IP address on WAN port. When you see Email server or Printer server disable in the
status table of Install Wizard or Admin pages, it implies DDNS has not been set.

Suppose there is already internet connection for your SC-203, to set DDNS
(1) Use your PC behind SC-203 to register a free DDNS service in the DNS
server, e.g. http://www.dyndns.orqg.
(2) Create an account (e.g. user name="larrywang”, password=98765), in the
DDNS server
(3) After you get the confirmation of your account, select and set a DDNS

domain name in the server. For instance, “larrywan.homeip.net” where the
9
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first part is you set, the remaining part “homeip.net” is you select from the
available list.

(4) Enter SC-203 admin page->WAN setting>Web Name (DNS) setting
Select Dynamic DNS server, choose Dyndns.org
Enter Username, Password and Domain name, e.g. “larrywang”, “98765” and
“larrywang.homeip.net” respectively

3.4 User Account Settings
User Accounts should be created before you open Email server, Portal services,
NAS, and Access Control to use. It is done by Administrator:
(1) Admin logins SC-203, enters admin pages
(2) User Account Control->Add User Account (on the top-right corner)
(3) Follow the instruction to complete and Save the settings. Refer to Help
message if you have difficulty.

4 Applications

4.1 Printer Sharing & Internet Printing
Printer server Settings includes:

(1) Basic Settings is complete for your SC-203 (See Chapter 3)

(2) Your USB printer is connected to USB1/2/3 port of SC-203

(3) Power-on printer

(4) In PC, Control Panel->Printer & Fax-> Add a new printer-> select Network
printer URL http://(SC203 domain-name or IP address):631/printers/usb

(5) Select the printer model in the Windows list. If it is not found on the list,
install the printer driver.

(6) Follow the instruction. Set the network printer as Default if you like.

(7) Then you can print your files in Words, Adobe, Power Point, Browser

(8) You can print it from remote site over Internet

4.2 E-mail Server
E-mail Settings includes:

(1) Basic Settings, particularly DDNS and User Account, is complete

(2) If using web mail, no matter your PC is, you can http://(domain name)
SC-203, user account logins, then edit, send, receive, delete mails and
move mails among folders.

(3) If using Outlook, create mail user account in Tools->Account->Add->Mail
Enter account name and password user name as SC-203 user account,

10
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and POP3/SMTP address as SC-203 domain name. Then the new Email
account will appear.
(4) Click the account->Server, check “My server requires authentication”

4.3 Web Server & Web Pages DIY

(1) Basic Settings, particularly DDNS and User Account, is complete

(2) Admin logins>Web Portal Edit to edit the SC-203 Home page Follow the
instructions to change titles, logo, pictures, system messages

(3) Each account user’s Web Site Page can be customized, following the steps :
-Edit your web page in your PC. This page cannot be interactive.
-Login admin pages—> Page Edit-> Upload the pages from PC to SC-203.
Note that one Web page could consists of multiple files, including
index.html.

(4) Public users can visit SC-203 home page by http://(sc203-domain-name)

(5) Public users can visit SC-203 user’s personal web pages by
http://(sc203-domain-name)/~(username)

4.4 NAS (Network Disk)

(1) Basic Settings, particularly DDNS and User Account is complete

(2) You can upload or download files from/to PC, no matter where it is. You can
use HTTP or Samba to do that

(3) http://(domain-name), user logins=> My File Then upload or download files

(4) In browser, type \\(domain-name) Choose the share folder Network_Disk,
type-in Username “guest”, Password “guest”. Then drag the files or folders
between PC directories and Network_Disk

4.5 Streaming NAS (Server)

(1) Streaming content could be placed in SC-203 Public & User’s Private area

(2) Protocols used : Samba, HTTP

(3) Upload streaming files to SC-203 Public area in different ways :
-PC uses Samba to access SC-203 shared folder (network_disk) in browser
\192.168.5.1\network_disk Then use Media Adapter WS-302 (guest, guest)
to stream it
-USB copy-in. Put the files under folder DCIM (This folder is commonly found
in most digital camera). If you use USB flash disk, create DCIM folder by
yourself first.
-Copy files from private to public area of SC-203. First user login
SC-203->My File>Edit Then follow instruction

(4) Upload streaming files to SC-203 Private area

11
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-Use WS-302 to do navigation and play of files in SC-203 private area

(Samba)
-Use PC browser to do navigation and play of files in SC-203 private area
(HTTP)
Samba HTTP
Server Content | SC-203 public area SC-203 public

location SC-203 private area SC-203 private
Client WS-30X media adapter WS-301, WS-304 Set-top-Box
Player PC/Media Player PC/Media player

Stream format

(depend on player, low bit-rate format MPEG-4, DivX-AVI,
WMV is preferred)

Max data-rate

10M bps (Ethernet)
AM bps  (WiFi)

10M bps (Ethernet)
4M bps  (WiFi)

(5) Stream-able File formats depending on your player support WS-302

supports : DivX-AVl, MP3, WMV9, MPEG4 and MPEG2 , VOB (DVD copy

files)

(6) It can support 2 streams simultaneously depending on the file bit rate and if

there is other background traffic, e.g. big file transfer

1 6. Content uploaded in public area
1 7. Content uploaded in private area

1. Digital Audio/Video files are created (movie in MPEG4,
DivX or WMV9) or copied from DVD-ROM or TV capture !

cards.

2. Putthe files under share folder Network_Disk,
: with username “guest & password “guest” !
3. Or upload the files to SC-203 public area with Samba by !

\\(domain-name)

4. Or upload the files to SC-203 private area with HTTP by :
: http://(domain name) and login user account !

! 8. Use Remote Control to set Network/Video/Audio
9. If Remote device is SC203, all default settings

are valid (ssid=sc203, Remote IP =192.168.5.1) !

! 10. Use Remote Control to browse the contents &

: do trick play (Pause, forward, Backward, OSD |

Repeat, Time Seek..) :

Streaming NAS (Server)

4.6 Photo Album, Video Library, Music Box

(1) Photo/ Video/ Music files can be imported from USB devices to SC-203 public

space by push the “Copy” button. In USB storage, all the files should be

12
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under DCIM folder

(2) Photo/Video/Music files can be HTTP uploaded from PC to SC-203 personal
private space by user login=> Photo Album

(3) Folders can be created and deleted

(4) Thumbnail directories : show reduced size photos of the files under a directory

(5) Full-size photo on click to display on PC or WS-302

(6) Photo print to the USB printer connected to SC-203

(7) Click on the picture file for down-loading to PC

(8) Video / Audio can be streaming played on PC and WS-30X

4.7 VolP Access

(1) SIP server in SC-203 is plug-and-play, nothing to configure

(2) Work with Gateway and IP phones, allows users to make free long-distant
phone calls, no matter where they are, even behind NAT (with private IP).

(3) Support standard SIP devices : Uni-PDA, Uni-Phone, PSTN Gateway, MSN,
PC soft phone

(4) All IP phones are registered to the SC-203 at regular time by :
Set sc203 address to “Registrar” and “Proxy” in IP phone

(5) An extension number is set to each IP phone. With these number, they can
calls each other.

(6) It supports server-to-server inter-domain call service by :
(extension)@(sc203-address) or use Address Book,

Uni DDNS Server
I SIP server
Wall Phone inlet

SC-203

Plug-in anywhere (hot-spot,
\VOIP Serve7 ADSL Modem o YW ( P

office, home) with

I PI ‘\] L . ‘ Lnrtler:?;tnet Internet or Intranet access to
SC-203 Home server
AN WAN Line TEL LAN accegs | "= oL
it # -

~ SN
Uni-PDAN
\

\
31# k
\

-Phone,I
324/
/
/

244 s

9O#

WG-205
Gateway

N _—— -

VolP Phone number (example)

070-XXXXX-YY
. \
VolP prefix

Extension

Family Number (20~39),
Server

Number

Unication VolIP Total Solution for Home User

4.8 Guest Access
(1) Each member creates his own Guest list
(2) Guest is allowed to share & access personal files & messages
(3) Share files, a folder of files, messages and video streaming within group

13
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4.9 Access Control
(1) In SC-203, user accounts are used for all services, including access control,
email, NAS, personal portal pages, by :
Admin page ?User Account Control 22Add a new Account
(2) Parental Access controls Internet surfing by username, MAC id, total time &
weekly schedule by :
Admin page 2User Account Control >check a user 2Allowable time “Limit”
Then set Total and Schedule.
(3) To activate Access Control by :
Admin page ?User Account Control 2Surf-Net “start”
(4) When user opens his browser, it will be re-directed to SC-203 Home page.
(5) After user logins, he opens another browser session to surf internet as usual.

4.10 Other Applications
(1) Firewall and VPN GUI are hidden in SC-203 Home edition. However, you
still can retrieve it by http://(domain name)/cgi-bin/login or
http://192.168.5.1/cgi-bin/login. Then another Ul will pop-up
(2) In the Ul, you can set Virtual Server port forward and DMZ in admin
Ul->Firewall

5 Maintenance

5.1 Server Backup & Recovery

(1) Admin settings backup : ADSL account (user name/password), DDNS
account, member accounts, WiFi SSID, Channel, WEP key

(2) Member’s account backup : (write-down)

(3) Member’s data backup : upload download with PC regularly. PC are SC-203
are placed in different locations

(4) If you want to reset the device, push the Power button instead of making
un-plug & plug the power adapter directly.

(5) When city power fails suddenly, or you abnormally un-plug SC-203 power
adapter, that could cause internal hard disk crashed. However, when next
time power on, after you pushes the Power button, system will automatically
recover the defective hard disk sectors. This will take you 10 minutes (Power
LED blinking). Please be patient.

(6) You can initiate Hard Disk Recovery any time from admin Ul->System
Maintenance->Check Hardware File System

(7) When more serious error occurs and device cannot recover, Reset to
Factory Default is the last chance to make system recovery.

14
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« Help Message :

) | 5C-203

Server Center/SC-203

(i ¥ )

Time Sctting

T
Check Hardizk
Fle System

5.2 Reset to Default

(1) There are two ways to do Reset to Default — (1) one is from admin Ul (software
reset to default), and (2) the other is push the button inside a small hole on the

Itwill cause systern to reboot with current settings
Fehoot process may take 1~2 minutes, please be
patient You can reconnectto Gateway's home page
after the rebooting process completed dvhen the
power light on the Gateway stop blinking).

Itwill cause systern to rebootwith default settings.
Fehoot process mav take 1-2 minutes, please be
patient You can reconnectto Gateway's home page
afterthe rebooting process completed dthen the
power light on the Gateway stop blinking).

Ifyou think your system HD thard drive) isn't operate
propetly or files are corrupted, use itto fix the file
systern. Then the system will autormatically reboot to
fix and check any demage system files.

The process will take 10 to 30 minutes arwhen
power led light turn steady.

/ CopyRight @ 2004 Unication Inc. All rights reserved

bottom side of the device. The 2" way is used when system hangs-up.

(4) To press the reset button located in the tiny hole with a sharp object and hold

15



Server Center SC-203
Quick Guide v2.3

W

Unication

it about 3 seconds down till the power LED starts to blink to ensure that it's

been reset.
(5) System reboots for about 50 seconds.
(6) Open Internet Explorer to enter http://192.168.5.1. The Install Wizard will

pop-up again..

5.3 Firmware Upgrade
(1) This is intelligent on-line firmware upgrade mechanism

(2) Admin logins—> System Maintenance->Firmware Upgrade
(3) System will check if your SC-203 needs new version upgrade
(4) Follow the instruction to do that

16
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Unication Consumer Web Site

On www.uni.com.tw or ww.uni-wlan.com,

there is a Support Section where help and
tips are only afew clicks away. Here you
find the latest software updates, guides to

use the products more efficiently.

FCC Statement

This device complies with Part 15 of the
FCC rules. Operation is subject to the
following two conditions: (1) This device
may not cause harmful interference, and
(2) This device must accept any
interference received including
interference that may cause undesired

operation.

Guidelines for Safe and Efficient Use
Please read this information before using the

product.

Recommendations

e Always treat your product with care and
keep it in a clean and dry place.

e Do not expose your product to liquid or
moisture or humidity.

e Do not expose your product to extreme
high or low temperatures.

e Do not expose your product to open flames
or lit tobacco products.

e Do not drop, throw or try to bend the
product.

¢ Do not attempt to disassemble the product.

17
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